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In view of the reform of the PreVocational Education at Secondary level, we are 
pleased to provide to Educators and PreVocational students teaching and learning 
materials in line with the new Curriculum Framework-Secondary (PreVocational) which 
will now comprise of four years of schooling. 

The objective of the PreVocational education is to provide opportunities to learners to 
obtain a formal qualification after four years of schooling. It will also provide learners 
with  opportunities to branch out in either, further training in a number of vocational 
areas or to join the world of work or even to reintegrate the academic stream.  

This project necessitates a well-planned teaching based on a set of carefully designed 
materials. The MIE is providing the pedagogical support and appropriate materials 
for both teachers and pupils. We believe that all children are educable and we have 
incorporated in the text materials that would provide learning experiences appealing 
to a diversity of learners. We wish that teaching is based on a collaborative and 
consensual approach with the students as well as with the support of the home. 

We also hope that these materials will help everyone to obtain a clear idea of the 
PreVocational project. You will surely notice that the materials can benefit any learner 
and a much wider group of students than just the PreVocational stream. It will be 
followed by other more exciting ones to cover the whole of the four years.

I wish to thank all the staff of MIE under whose guidance these materials have been 
produced and the team of MIE graphic designers who have produced a wonderful 
piece of work. My thanks also go to the staff of the MITD who have been associated 
with the writing of the materials, the Educators from secondary schools who have 
contributed in various panels and the PreVocational Inspectors for their constructive 
comments.

Sheela Thancanamootoo
Director, MIE 
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This book is the first part of Year 2 (Year 1, Year 2, Year 3, and Year 4) designed 
for learners in the Pre-Vocational stream over a period of four years. The material 
provided gives a comprehensive view of basic computer literacy and operations. This 
is essential to get initiated into the use of computer in an informal manner. However, 
given tha nature of the student, it is expected that teachers use the manual and assist 
students, especially those who wll have a problem understanding the language. 
Educators can also refer to the Year 1 material for the basics.

We hope to get support from teachers and welcome suggestion for future revision 
of the manual.       

The units covered in this book are presented in the order set below:
Unit 1: Fundamentals of computer system
Unit 2: Computer operations
Unit 3: Word process
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funDamentals of 
a computer sYstem 

Unit 1

aim:

The aim of the unit is to enable you to learn the characteristics of 
the different types of computers and the input, output and storage 
devices.

objectives:

At the end of the unit, you should be able to:
• explain the characteristics of different types of computers.
• list out the different input, output and storage devices and their uses.
• differentiate between data and information.
• explain how data is stored in terms of bits and bytes.
• differentiate between analog and digital signals.

	 Instructions to teachers 



Unit 1: Fundamentals of a computer system 

Information & Communication Technology2

There are different types of computer system:
• Microcomputers
• Minicomputers
• Mainframe computers 
• Super computers.	

In this unit you will learn more about the characteristics of these types of computers and 
some computer terms such as data, information, processing, binary digit, bytes, analog 
signal, digital signal.

A Microcomputer is also called personal computer or PC. Microcomputers are small 
computers which are most commonly used in everyday life. They are single user machines 
(used by one person at a time). We use them at home, at school and in the office. Two 
microcomputers commonly used are desktop computers and laptops.

The desktop computer is generally placed on a table with the various part connected as 
you have seen in the computer room.

 

The laptop is usually a small and thin computer. It is also known as a portable computer. 
A laptop computer functions in the same way as a desktop computer.

1.1 computer sYSTEM

Instructions to teachers:
Brainstorm learners on 
the different types of 
Computers.



Minicomputers are faster and have much more data-storing capacities than 
microcomputers. They are multi-user machines (can be used by many users at a 
time). Minicomputers are used in banks, in supermarkets and in other small business 
companies. 

Mainframes are much faster and more powerful than the minicomputers. A large number 
of persons can use them at one time. They are usually used by large business organisations 
such as insurance companies, universities and banks. Mainframe computers must be 
kept in special air-conditioned rooms.

Supercomputers are very large and high-capacity mainframes which are used for specific 
purposes where speed and high processing capabilities are needed. They are used in 
many applications such as in meteorological stations for weather forecasting.
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Data Processing is the work that is done on data that has been input. 

Let us see the example below to understand these computer terms.

	       sugarcane 			    sugar factory 			     sugar
	           (Input)			                  (Process)				   (Output)

Sugarcane (input) is processed in a sugar factory (process) to produce sugar (output).

Let us take an example how the computer system does a simple task. We want the 
computer to add two numbers (2 and 8) and to display the sum.

		  Input                        	        Process            		        Output
	     (Keyboard)			     (System Unit)		        (Computer screen)

    Input: The keys 2, + and 8 are typed on the keyboard. 
    The addition of the two numbers is called processing. 
    The computer displays the result on the screen. This is called output.
    

The result is saved on a storage device so as not to lose it when the computer is switched 
off. This is called storage.

1.2 Data processing task of a computer system

1

1

2

2

3

3

2 8 +

2 + 8 = 10
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Data

Data is basic facts or figures we input into the computer using the keyboard, the mouse, 
the joystick or the scanner. Data can be in the form of alphabets, numbers, symbols, 
graphics, etc.

Input

Input involves entering data.

Information

Information is processed data. The computer processes data to give us information as 
numbers, examinations marks, weights, a person’s age, etc.

Examples of information are: exams report sheets, the CWA bill, the CEB bill, the telephone 
bill, the shopping bill, etc.

Processing

Processing is the manipulation of data by the computer system to produce information.

Manipulation means adding, subtracting, multiplying, comparing, sorting, dividing, etc.

Example:

	      input              	       processing                           output

Output

Output is the display of processed data which can be viewed on screen or printed on 
paper. 

1.3 Common computer terms

Marks for 
Mathematics 

test

40, 80, 30

Computer 
process 

data to give 
grades

MARKS	GR ADES

   40	     - 	     C
  80      -       A
  30      -       D
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Class Activity

Write, in the empty boxes, the output you will get 
for each of the following processes.

The first one has been done for you. 

	     input              	       processing                 output
a.

b.

c.

Flour, eggs, 
sugar, water

Test papers for 
maths, English, 
French, ICT, 
and other 
subjects

Baked by oven 
(four)

Teachers mark 
papers, give 
grades 

Pastry cake

Chicken, colour, 
potatoes, rice, 
spices, salt

Cooked in rice 
cooker

Instructions to teachers:
Do the activity orally 
first, followed by written 
tasks.
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1.4 Characteristics and uses of input and output    
      devices

Input and output devices are also called peripherals. They are usually connected to the 
system unit by means of cables and work under the control of the Central Processing Unit 
(CPU). Some common input and output devices are keyboard, mouse, joystick, monitor 
and printer.

Input devices

Input devices are hardware that are used to enter data and instructions to the computer 
for processing. 

Examples of input devices

Keyboard

The keyboard is used to type data into the computer. Each key of the keyboard represents 
either an alphabet, a numeric digit or a special symbol as you have seen in computer 
room.

The keyboard is mostly used to type letters, reports and other documents. 

Unit 1: Fundamentals of a computer system 
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Mouse

The mouse is a pointing device. It controls the movement of the cursor or the mouse 
pointer on the screen.

To select a file or an icon, you click on the left button. You can click on the right button to 
open a menu. The scroll button is used to move up and down the screen. 

The mouse is mostly used to open, close and save files.

Webcam

The webcam is an input device which provides the computer with video input. It is 
connected to the computer by a USB cable or can be wireless. It is widely used for online 
conversation to allow users to see each other. 

Left button

Mouse Pad

Right
button

Scroll
button

Webcam
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Glass window

Lid

Microphone

The microphone helps to input voices and sounds into the computer. It is used in computers 
for audio recording. 

Joystick

A joystick is an device which can be moved in various directions. The joystick is often 
used to play video games and also for controlling other machines.

Scanner

An image scanner is often called a scanner. It is an input device that converts images, 
printed text or other document to a digital image that is stored in the computer. 

Desktop (or flatbed) scanner as shown in the picture is mostly used in office and at home. 
The document is placed on a glass window and the lid is closed before scanning. 		

Unit 1: Fundamentals of a computer system 
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Barcode reader
						    
A barcode reader (or barcode scanner) is an input device to scan barcodes (black lines 
as shown in the picture) on books, foodstuffs containers, clothes, etc. Barcode readers 
are widely used in supermarkets and libraries. 

Barcode

Barcode
reader

Output devices

Monitor

A monitor also called visual display unit (VDU) is an output device to display the processed 
data and other information on a screen. 

Types of monitors 

Computer monitors are mainly of two types: the CRT monitor and the flat screen 
monitor.

CRT monitor - CRT stand for Cathode Ray Tube.	
		

Unit 1: Fundamentals of a computer system 
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Flat screen

LCDs are flat screen monitors. LCD stand for Liquid Crystal Display. Flat screen monitors 
are more expensive than CRT monitors. 									       

							               	

Printer

The printer is an output device which prints documents (texts and pictures) on paper or 
transparencies (special plastic). The printout is known as a hard copy. There are different 
types of printers.

Types of printers

There are two main types of printers namely:  impact printers and non-impact printers.

Impact printers

Impact printers are normally noisy printers such as dot-matrix printer. They print by striking 
on inked ribbon. The characters are printed on paper by a pattern of dots. 

						      Impact printers
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Non-impact printers
 
Non-impact printers are normally quiet and fast printers.  There is no physical contact with 
the paper while printing. Examples of non-impact printers are Ink jet printers and Laser 
printers.

			   			   		
	
			   	

		           
		             Ink-jet printer		   		   Laser printer

Nowadays we have the Three-in-one printers with printing, scanning and fax all in one 
machine.

					         Three-in-one printers

The table below summarises the characteristics of the different types of printers.			 
					     	

Printer			   	 Characteristics

Dot-Matrix			   	 Noisy, cheap, slow and poor print quality  

Ink-Jet			   	 Quiet,  colour printing of better quality

Laser				    	 Quiet, expensive, fast, colour printing, 
				    	 very good quality printing
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Plotter

The plotter is mostly used to print large graphical designs, technical drawings, and 
architectural plans. The pen plotter can print many lines of different colours at the same 
time. The paper is fixed to a surface, and pens are moved across the paper to produce 
the image. The plotter is mostly used by designers and architects.

Types of plotters
 								      
Two common types of plotters are: drum plotter and flatbed plotter. 

Drum plotters

A drum plotter rotates the paper as the pens move across it to draw the image as shown 
in the picture. 

Flatbed plotters

A flat-bed plotter is mostly used by designers. The paper remains stationary on a flat 
surface while a pen moves across it horizontally and vertically as shown in the picture.		
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1.5 Binary digits (Bits) and bytes

Look at the electrical switch.
It has only the OFF and ON position. 

The OFF position may be represented by the digit 0.
The ON position may be represented by the digit 1. 
The digit 0 and the digit 1 are known as binary digits (bits). 
A character is stored as a combination of 8 bits which is called 1 byte. 

Examples 							       One byte = 8 bits

		  The letter ‘A’ is stored as 			  0 1 0 0 0 0 0 1

									                          
								        0 1 0 0 0 0 0 1

		  The number ‘2’ is stored as		  0 0 0 0 0 0 1 0     
    
								        One byte = 8 bits		           	

1 bit

0 bit

Speakers

Speakers are usually used in pair, the Left speaker and the Right speaker. It is an output 
device used in multimedia computer system where the user can listen to music, voices 
and other sounds. 

Unit 1: Fundamentals of a computer system 

Information & Communication Technology14



		  The symbol ‘=’ is stored as 		  0 0 1 1 1 1 0 1

								        One byte = 8 bits	
The word cat is stored as 3 bytes.
When we press the spacebar on the keyboard, the space is stored as 1 byte.

Class Activity 

Today is Sunday.  

Count the number of bytes in above sentence. 
The 2 spaces and 1 full stop must also be counted. 

The total number of bytes stored will be 16 (13 alphabets, 2 spaces and 1 
full stop).

Now do the following:
(a) Write your name.
      _________________________________________________________________.

(b) Count the number of bytes and write it in the space below.
       Total number of bytes: _____________

(c) Write the name of your school.
      _________________________________________________________________.

 (d) Total number of bytes: _____________

Unit 1: Fundamentals of a computer system 
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Do the activity orally 
first, followed by written 
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            Name of storage medium				C    apacity

		

	 Floppy disk							       1.44 Mb

	 Hard disk							       120 Gb or more

	 Compact disk						      700 Mb or more

	 DVD								        7 Gb or more 

	 USB pen							       512 Mb, 1Gb, 

									         2 Gb or more

	 Memory card						      512Mb, 1 Gb, 

									         2 Gb or more

1.6 Storing capacity of storage media

Storage media are used to store information 
permanently. This is important because the computer 
memory can store the information temporarily. When 
the computer is switched off, all information will be 
lost. 

Let us learn about the storage capacity of a floppy disk , a Compact disk (CD), USB pen 
or memory card when using them. The capacity is measured in Kilobytes, Megabytes 
and Gigabytes.

			   1 kilobytes (Kb)		  1000 (1 thousand) bytes

			   1 Megabyte (Mb)		  1,000,000 (1 million) bytes

			   1 Gigabyte (Gb)		  1000,000,000 bytes

Unit 1: Fundamentals of a computer system 
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Brainstorm on  the 
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1.7 Analog and Digital signals

Examples of analog and digital devices.

      Purpose			            Analog Device                        Digital device

Reading time

Weighing

Reading blood 
pressure

Similarly data are transmitted either through analog, digital signals or both.

Analog signals

Analog signals are continuous signals in waves form that have constant fluctuations, as 
shown in the picture below.
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Digital Signals

Digital signals are electronic signals transmitted by the computer as binary codes 
(1’s and 0’s), in a pulse train to represent data. An example is given below:

The data which is stored in form of bits (binary digits) on one computer can be sent to 
another computer in the form of digital signals.

Unit 1: Fundamentals of a computer system 
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UNIT 1: ACTIVITY SHEET 1

Name: ..................................................…………………………………………………

Class: ............................................................……………………

1. Complete the following statements.

(a) The computer processes ______________ to produce ______________.

(b) It uses ______________ devices such as keyboard and ______________ 

     devices such as the monitor.

(c) It stores information as ______________ digits.

(d) Those digits are called bits. A bit can be either a ________________ or a 

      ______________. 

(e) Eight bits form one ______________. The term byte is used to measure the

      capacity of computer memory.

2. Match each unit with its correct value 

	     Column A				     Column B

	 1 Kilobytes				    1000 million bytes

	 1 Megabytes			   1000 bytes

	 1 Gigabytes				   1 million bytes





UNIT 1: ACTIVITY SHEET 2

Name: ..................................................………………………………………………

Class: ............................................................……………………

1. Draw the digital signal for the following binary code 0 0 1 0 1 1 0 . 	

2. Write the binary code for the following digital signal.	

  
Binary code	     _________________________________________				  
					   
3. Count the number of bytes in each of the following:

(a) Port Louis

(b) Three input devices are: keyboard, mouse and joystick.

(c) Where did you go during the week-end?





UNIT 1: ACTIVITY SHEET 3

Name: ..................................................…………………………………………………

Class: ............................................................……………………

1. Make a list of data items you will need for the following processing tasks: 
	
		  Processing task					     Data

  To withdraw money from ATM           PIN code, transaction code, 
						      amount of money

  To multiply two numbers	

  To make a list of pupils of year II 	

  To produce bus pass for pupils	

  To borrow books from the library	

2. Write ‘True’ or ‘False’ for each of the following statements:

		  Statement						            True or False

   A minicomputer is used by pupils at school. 
	
  All computers have microchips and storage 
  devices.	

  A mainframe can be used by only one person at a time.
	
  Hard copy is the term used for information 
  displayed on the screen.	

  Laptop computers can be used anywhere once 
  they are charged.	





UNIT 1: ACTIVITY SHEET 4

Name: ..................................................…………………………………………………

Class: ............................................................……………………

1. Answer the following questions.

(a) What is the name given to a group of 8 bits?

      _____________________________________________________________________

(b) What storage medium you will use to store a movie?

      _____________________________________________________________________

(c) What is the most common output device of a PC?

      _____________________________________________________________________

(d) Why is the laser printer called a non-impact printer?  

      _____________________________________________________________________

(e) Name two characteristics of impact printers.

      1. ___________________________________________________________________

      2. ___________________________________________________________________

 2. What do the following stand for:

(a) BIT : ________________________________________________________________

(b) CPU : _______________________________________________________________

(c) VDU : _______________________________________________________________

(d) LCD : _______________________________________________________________

(e) Mb : ________________________________________________________________





UNIT 1: ACTIVITY SHEET 5

Name: ..................................................………………………………………………

Class: ............................................................……………………

1. Encircle the letter representing the correct answer for each of the 
    following statements.

(a) A monitor displays the words that you type on a keyboard. 

      This is an example of _______________.

A  An input		  B    A process	 C    An output	 D   A data storage

(b) Which one of the following operates without a microprocessor?

A  Microwave Oven	   B  Washing Machine    C  Electric bulb     D  Computer Sytem

(c) A calculation is an example of _______________.

A    Input		  B    Processing	 C    Storage		 D   Output 

(d) Movies are usually copied on _______________.   

A    DVD		  B    Floppy disk	 C    CD-ROM	 D    Audio tape

2. Fill in the blanks with the appropriate word. 

(a) A _______________ is an example of a pointing device.

(b) A speaker is an _______________ device.

(c) Data is stored in the computer as _______________.

(d) Input and output devices are also called _______________.





UNIT 1: ACTIVITY SHEET 6

Name: ..................................................…………………………………………………

Class: ............................................................……………………

1. Match the following.

    Microphone is				    data manipulation by the computer

   Output is					     known as the brain of the computer

   Central Processing Unit is		  an input device

   Processing is				    produced after a process

		

2. Write the most appropriate input or output device used for each of 

    following activities.

(a) Typing a letter : ______________________________________________________

(b) Playing games : ______________________________________________________

(c) Printing the plan of a building : ________________________________________

(d) Reading the bar code in a supermarket : ______________________________

(e) Drawing a house : ____________________________________________________





UNIT 1: ACTIVITY SHEET 7

Name: ..................................................…………………………………………………

Class: ............................................................……………………

Identify the following devices as either analog or digital.

      ____________ 			   ____________		  ____________
      thermometer                            ammeter                                clock

     ____________ 			   ____________		  ____________
       barometer       		        clock                      clinical-thermometer

         ____________ 			  ____________		  ____________
              calliper                              ammeter                          barometer





computer operatIons 
Unit 2

aim:

The aim of the unit is to explore windows environment for further 
computer operations.

objectives:

At the end of the unit, you should be able to:
• learn about the general features of the desktop settings and 
   managing the toolbars.
• know the features of the computer and the hard disk properties.
• get familiarize with the different utilities within the Windows  
   operating system.

	 Instructions to teachers 



2.1 Windows Environment

Desktop Background

The background of the desktop can be changed as per your choice, where the design 
of the background can be either from the list provided in the computer itself or you can 
load your own designs or pictures.

Desktop Setting
    
The desktop setting can be changed by following the steps below:

Right-click on any empty place on your desktop, a list of options will appear.
Select Properties.

The ‘Display Properties’ window will appear.

Click on the Desktop option in the window. 
A list of different background will be provided and the actual picture of the desktop 

       will be active in the window.

Unit 2: Computer operations
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4

4

5

5

Scroll on the Display properties window and select a background option for 
example: select Autumn.

Click on Apply and then Ok.
The new background of the desktop will be displayed as follows.

Unit 2: Computer operations
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Class Activity 

Arrange the given steps for “Changing the Desktop 
Background” by numbering them correctly.

Choose your chosen background, for e.g. ‘Bliss’ 

Select ‘Properties’

Click on ‘Apply’ and then ‘OK’

Right-click on any empty space on the ‘Desktop’

Click on ‘Desktop’ in ‘Display Properties’

2.2 Exploring the Program menu

The program menu provides a list of some additional options where you can do further 
operation, such as getting access to specific program such as Ms Paint, games option, 
exploring My Documents or even search for a file or folder.

The Program Menu can be accessed:
Clicking on Start button.
Clicking All Programs.

The list of programs of the menu will be displayed 
as follows.

1

1

2

2

Instructions to teachers:
Do the activity orally 
first, followed by written 
tasks.
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Games

Games is a folder containing several types of computer games.

To load a game on the computer, follow the steps below: 
Click on All Programs.
Select Games, a list of the available games will be provided.
For example select Pinball.

The “Pinball “game window will open as below, and it can be played by using the 
arrow keys on the keyboard.

1

1

2

2

3

3
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Calculator

The computer provides the facilities of a calculator, where arithmetical operations such 
as adding, subtracting, division and multiplication can be done.

To use the calculator, follow the steps below:
Click on All Programs

Select Accessories

1

1

2

2
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1
2

3

3

3

3

Click on Calculator

The calculator appears on the desktop. The numbers can be typed either using the 
keyboard or clicking on the calculator using the mouse. The calculator can be closed by 
using the exit button.

Notepad

The Notepad enables you to create and edit text files using basic text formatting. For 
example, documents can be typed in Notepad.

To use Notepad, follow the steps below:
Click on All Programs.
Select the option Accessories, and then click on Notepad.
The Notepad window appears.

Unit 2: Computer operations
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In the Notepad window, text can be typed as the following.

You can save your document, by the steps in the following screen.

4

5

Practical Lab Activity

Open Notepad, type the following text.

The Computer is an electronic machine 
which is used to process data into 
information.

Save the file as Notepad1.

Instructions to teachers:
Do the a demonstration 
first of the activity followed 
by practical session
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2.3 Locate and run file

You know that information can be stored in the hard disk, pen drive, CD or DVD.  File can 
be located and re-opened from the location it has been stored.  

Practical Lab Activity
In previous activity, a file named Notepad1 has been saved in a folder 
called My Documents, in the hard disk.

You know how to load Notepad.  So, follow the necessary steps to load 
Notepad1.

1. Click on File and select the option Open.

2. The window will a provide a list of files that is stored in My Documents.

Unit 2: Computer operations
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3. Select Notepad1 and click Open.

4. The file Notepad1 will appear as shown in the screen below.

Unit 2: Computer operations
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In the following activities, you will practise some operations on files and folders.

2.4 Files and Folders

Practical Lab Activity
Searching of files and Folders
In this activity, you will search for the file Notepad1, through the following 
steps below, by using the Search option.

1. Click on the Start button.
2. Select the option Search.

3. In the window below, click on All files and folders.
1

2
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4. In the option All files and folders, type Notepad1, 
    then click on Search.
    The computer automatically searches for the file.

5. If the file is found, the name of the file and the location where it is 
    stored are displayed. 

Unit 2: Computer operations
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Rename, move, copy and delete files and folders

Files and folders can be renamed. It can be copied, moved and deleted. In the steps 
below, you will learn how to rename, move, copy and delete files and folders. 

Practical Lab Activity

Renaming Files

A file can be renamed by choosing the options shown below.

1. Locate the file “Notepad1” from the Search option.

2. When all the files are displayed, right click on the file Notepad1, and   
    in the option list select Rename.
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3. Press the delete key to erase the name Notepad 1, 
   and type Wordpad1 as the new name.

Just the file name will be changed.

Moving and copying files and folders

A file or folder can be moved or copied to another location. For example the file Testing 
on the desktop shown below can be copied or moved on another drive or folder.

Steps for copying a file with copy and paste
Right click on the folder ‘Testing’
Select the option Copy.

1
1

2

2

Unit 2: Computer operations

Information & Communication Technology46



Right click and select the option Paste to copy the folder .

The folder will be copied on the desktop.

Steps for moving a file with cut and paste.
Right click on the folder to be cut.
Select the option Cut.

1

1

2

2

3

3

4

4
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The file will be removed from its current location.
Select the option Paste in its new location by right click.3

3

Deleting files 

Deleting a file is to erase the file.
Follow the steps below:

Right click on the file to be deleted.

Select option Delete.
A message box will appear asking whether you want to delete the file or not.

1

2

2
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1

1

2

3 If the option ‘Yes’ is chosen the file will be erased; if ‘No’ the file is not deleted.

2.5 Managing different windows at the same time

Several windows can be opened at the same time and used on the computers.

To open and work with several windows, follow the steps below.
Open  a file for example the file Wordpad1.
 The window will appear on the desktop.

Click on the borders with the mouse, and reduce its size.
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Open another window, “My Computer”

Resize the ‘My Computer’ window as done previously
Another window can be placed on the desktop.
For example, to explore the ‘System C’

Right click on ‘System C’.
Select Explore or Open.

3

4
5

2
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The window for the Drive C (system C) will open with the desktop.

Resize the window so that it can appear on the desktop alongside with the other 
two windows as shown below.

4

5

6

6

7
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‘My Computer’ is a system folder which gives an overview of the features of the computer 
system, in terms of its hard disk drives, files stored and other devices.

To explore the Computer system, follow the steps below
Right-click on the icon Computer.
Select Properties.

2.6 Exploring My Computer

7

1

1

2

2
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Properties of the Hard disk 

You can view the properties of the hard disk in a computer by following the steps 
below:

Click on start
Right Click on My Computer 
Click on Explore.

This will display the details of the computer system as shown in the window below.

1

2

1
2
3

3
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Right click on Local disk C or System C, and select Properties.
The memory space of the hard disk is shown in terms of the free and used space

Types of drives

A computer gives access to several drives where you can read and load information 
from it. 
For example, the hard disk in the computer is known as the local disk, and all information 
stored on it is referred to be in the Drive C or system C
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Other Drives

The computer recognises other drives such as the CD or DVD drive. They are displayed as 
the Drive D: but if the local disk has been referred as the Drive D, then the CD-DVD drive 
becomes Drive E:

If a pendrive is plugged, it is recognized as the Drive F.

Exploring the properties of any device such as a CD, DVD, pendrive can be done in 
the same steps as explained above, where you can know the memory space of each 
device.
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There is also the facility of viewing a document before it in printed. The following steps will 
guide you to preview a document on screen, then print if found correct.

Steps to Preview and Print a document.

Open the document to be printed.
Select File, and click point on the option Print.
To preview the document before printing, click on Print Preview.

2.7 Print Preview and Printing 

1
2
3

2

3



The Printing option window will be opened as follows:
If you have several pages to print, Select All, or if only one page has to be printed, 
select current page.
The number of copies to be printed can be modified as per your need.

Click Ok.7

This will give you a preview of how the document will appear when printing.

To close the print preview, select the option Close Print Preview
To print the document, select the Print Icon.

4
5

45
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1
2

2

2.8 Recycle Bin
The Recycle Bin of the computer is where deleted files and folders are stored in the 
hard disk.  Those files can be restored when needed.  

Sending files to Recycle Bin

Basically a file is sent to the Recycle Bin when it is 
deleted.

Steps of sending a file to the Recycle Bin
Right click on the file, or folder or an icon to be deleted.
Select the option Delete.
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A message box will appear.

Click Yes to send the file to the Recycle Bin.3



Restoring a file from Recycle Bin

File that has been deleted and sent to the Recycle Bin can be restored.  It can then be 
re-opened and used again.
The steps below will indicate how a file can be restored from the Recycle Bin.

Right click on the icon ‘Recycle Bin’.
Select the option Explore

All the files stored in the Recycle Bin will be displayed on screen.

1

1

2

2
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Name: ..................................................………………………………………………

Class: ............................................................……………………

Exploring the properties of the different drives in ‘My Computer’.

Note down the capacity (Used and Free Space) of 

						      Used Space_____________ , 

						      Free Space____________ .

						      Used Space_____________ , 

						      Free Space____________ .
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Name: ..................................................…………………………………………………

Class: ............................................................……………………

Fill in the blanks to show how to proceed with ‘Print Preview’ and ‘Print’. 
(The words are already given). 

All, Button, Print, On, Preview, Close

a. Click on “Office .........................”

b. Select ‘.....................’.	

c. Select ‘Print ..................’ (If you want to see the page before printing).  

d. ‘........................’ Print Preview’.

e. In ‘Print’ window, choose ‘.............’. 

f.  Click...... ‘OK’.	
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Name: ..................................................…………………………………………………

Class: ............................................................……………………

Sending folder to the ‘Recycle Bin’.

Arrange the steps in the correct order for ‘Deleting a Folder’, by numbering 
it with 1,2,3,4.

If the option Ok is selected, the file will disappear. 	
		
Select the option ‘Delete’				  

A message appears asking whether you are sure you want 
to delete the folder.			 

Right-click on the folder.			





Name: ..................................................………………………………………………

Class: ............................................................……………………

Restoring a deleted file from the ‘Recycle Bin’.

Copy the steps in the correct order in the space given.
Select the option Explore.
Select Restore.
Select Ok.
Right click on the icon Recycle Bin.
Right click on the File that has to be restored.

Step 1: _____________________________________________________________

Step 2: _____________________________________________________________

Step 3: _____________________________________________________________

Step 4: _____________________________________________________________

Step 5: _____________________________________________________________
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Name: ..................................................…………………………………………………

Class: ............................................................……………………

Give the names of these icons:
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Name: ..................................................………………………………………………

Class: ............................................................……………………

Using “Calculator”, carry out these simple Mathematical problems and 
note down your answers.

(i) 2435 + 740 =  

Answer:  ______________

(ii) 500 – 262 =  

Answer:  ______________

(iii) 454 + 2910 -1230 = 

Answer:  _____________

(iv) 120 x25 =

Answer:  ______________

(v) 2379-1300 + 200 ÷ 3 =

Answer:  ______________
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Name: ..................................................……………………………………..…………

Class: ............................................................……………………

Draw any 4 (four) icons or files and folders, which are found on the Desktop 
and name them.

	 (a)

	 (b)

	 (c)

	 (d)
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WorD processIng
Unit 3

aim:

The aim of this unit is to familiarise you with more word processing 
techniques.

objectives:

At the end of the unit, you should be able to:
• format texts, paragraphs, documents.
• create bulleted and numbered lists.
• insert Headers/Footer and Page Numbers.
• apply borders and shading to a page and to paragraphs.
• use different tools such as Spell Check, Grammar, Thesaurus,  
   Find & Replace, Drawing Toolbar.
• insert and format pictures and tables.

	 Instructions to teachers 



3.1 Character formatting
Formatting the character means changing the font - its size and type colour. You already 
know how to format characters. Let’s do an activity to revise what we learnt in Year 1.

Class Activity 

Match the following buttons to its respective 
function:

 					     It converts your 	

					     text into italics, e.g book

					     It changes the font type in your text

 					     It changes the font size in your text

						    

 					     It underlines your text, e.g book

					     It makes your text bold, e.g: book

 					     It changes the colour of the text

3.2 Paragraph formatting 

Paragraph formatting involves the Alignment, Line spacing, adding bullets and numbers.

Instructions to teachers:
Do the activity orally 
first, followed by written 
tasks.
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Paragraph Alignment

Different types of alignments are available in Microsoft Word. You can align paragraph 
lines centrally, to the left or to the right. You can also justify lines.

Right alignment

To right align the paragraph, follow these steps:
1. Highlight the paragraph.
2. Click the Home menu.
3. Click the Align-right button  in the Paragraph group. Word right-aligns 
    your paragraphs.

Practical Lab Activity

Type the following text:

The hardware includes the processor and peripherals. Computer 
peripherals are any electronic devices that can be connected to a 
computer other than the standard input / output devices. Peripheral 
devices may include speakers, microphones, printers, scanners, digital 
cameras, plotters and modems.

1

2

3
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Left alignment 

To left align the paragraph, follow 
these steps:
1. Select the paragraphs you 
    created.
2. Choose the Home tab.
3. Click the Align-left button  in 
    the Paragraph group. Word 
    left-aligns your paragraph.

Centre
 
To center the paragraph, follow 
these steps:
1. Selected the paragraphs you 
    created.
2. Choose the Home tab.
3. Click the Center button  in the 
    Paragraph group. Word centers 
    your paragraph.

Justify
 
To justify the paragraph, follow 
these steps:
1. Select the paragraphs you 
    created.
2. Choose the Home tab.
3. Click the Justify button  in the 
    Paragraph group. Word 	    
       justifies your paragraph.

1

1

1

2

2

2
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3

3
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Class Activity 

You have been given three paragraphs below 
where different paragraph alignment has been 
used. Write down the alignment used in the boxes 
below:

Sweet is thy beauty, 
Sweet is thy nation.  
Around thee we gather, 
As one people, 

Glo-o-ry to thee
Motherland,

Oh Motherland of mine,

As one nation.  
In peace, Justice and Liberty,

Beloved country, May God Bless thee.  
Forever and Ever.

Line spacing

The line spacing is the space between two lines. The most commonly used line spacing 
feature is: single spacing, 1.5 spacing and double spacing.

Instructions to teachers:
Do the activity orally 
first, followed by written 
tasks.
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Practical Lab Activity

To change spacing, follow these steps:

1. Type the following text:

Humpty Dumpty sat on a wall.
Humpty Dumpty had a great fall.
All the king’s horses and all the king’s men
Couldn’t put Humpty together again!

NOTE: this document has single line spacing.

2. Now, highlight the whole paragraph. 

3. Click on home tab, click on arrow 

    next to paragraph.

4. Select 1.5 lines, observe what 

    happens.

5. Select double, observe what 

    happens.

2

3
4
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Adding Bullets 

If you have lists of data, you may want to bullet or number them. When using Microsoft 
Word, bulleting and numbering are easy.

To add bullets, follow these steps:
Type the following list as shown:

	 Apple 
	 Orange 
	G rape 
	 Mango 
	C herry

Select the words you just typed
Choose the Home tab

In the Paragraph group, click the down arrow next to the Bullets button
The Bullet Library appears
Click to select the type of bullet you want to use. Word adds bullets to your list

Your text should be as follows:

1

2
3

4

5
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Adding Numbering

To add numbers, follow these steps:
Type the following list as shown:
	 Apple 

	 Orange 
	G rape 
	 Mango 
	C herry

Select the words you just typed. 
Choose the Home tab.

In the Paragraph group, click the down arrow next to the Numbering button.
The Numbering Library appears.
Click to select the type of numbering you want to use. Word numbers your list.

1

1

2

2
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3
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3.3 Insert Headers/Footers

The header is the text that appears at the top margin of each page and footer is the 
text that appears at the bottom margin of each page.

Headers and Footers can show the page number, date and time, tiles and authors 
names and so on. Ms Word shows the same header / footer on all pages in a docu-
ment.

Insert header

To insert a Header follow these steps:
Click on Insert tab
Click on Header

1
2

2
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Choose the header format you prefer. Type your “computer studies” as header. The 
screen will appear as follows:

Insert footer

To insert a footer follow these steps:
Click on Insert tab
Click on Footer

Choose the footer format you prefer. Type your “PV 2” as footer. The screen will appear 
as follows:

1

1
2

2
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3.4 Insert Page Numbers

It is common to insert page numbers on each page of a document which consists of 
more than one page. The page number is normally inserted at the top or at the bottom; 
moreover, it may be positioned on the left, at the centre or on the right.

To insert page numbers follow these steps:
Choose the Insert tab
Click the Page Number button in the Header & Footer group. A menu appears.

Click Bottom of Page
Click the right-side option 
The page number appears 
as follows:

1
2

2

3
4
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3.5 Inserting borders and shading
Borders are decorative lines used along the edges of our pages, texts, tables or around 
graphics to enhance their look.

Shading adds colour to our documents and tables.

Insert a Page border

To add page border, follow these steps:
Click on Page Layout tab
Click on Page Borders
Choose a Border Style

Your page will be as follows:

1
2

2

3

3
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Your document will be as follows:

Paragraph border

Practical Lab Activity

To change spacing, follow these steps:

1. Type the following text:

Harry Potter was a bright eleven-year old who lived with his 
miserable aunt and uncle and their horrible son Dudley. Harry’s 
parents were killed when he was a baby and he had lived with 
his relatives ever since. Dudley and his friends were bullies who 
tormented Harry whenever they could. Harry could only recall a 
handful of days in his life when he had been truly happy.

To add paragraph border, follow these steps:
1. Highlight the paragraph
2. Click on page layout tab
3. Click on page borders
4. Click on borders
5. Choose a border style

Your paragraph will appear as follows:
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To add shading to your paragraph, follow these steps:
1. Click the shading tab.
2. Click the Fill list arrow, and then click a fill colour.
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Class Activity 

1. Circle the letter which shows the correct answer.
I. If we wish to number the items in a list we click on   
   the ....................... button.

Your paragraph will appear as follows:

A		         B		                C		            D

Instructions to teachers:
Do the activity orally 
first, followed by written 
tasks.
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II. ................................ are features used for placing information at the 

top and bottom of every page of a document.

A     print preview					     B    headers and footers

C     page number					    D    margins

III. We add borders around our text to.........................................................

A    count our text

B    shade our text

C    make it look more attractive

D   shorten our text

2. Write true or false in the box at the end of each sentence.

a) A border is a decorative line around the edges of a 

    page or graphic.

b) Line spacing allows space between two lines.

c) The shading feature adds colour to our documents.

3.6 Use Spelling and Grammar Check

Ms Word automatically checks for spelling and grammar errors as you type unless you turn 
this feature off. Spelling errors are noted in the document with a red underline. Grammar 
errors are indicated by a green underline.

Type the word: ‘mouce’
Select the word ‘mouce’
Choose the Review tab
Click the Spelling & Grammar button. The Spelling and Grammar dialog box appears.

1
2
3
4
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3.7 Use Thesaurus

The thesaurus tool helps you to expand your vocabulary. It offers alternatives for a word. 

Type the word: ‘happy’
Select the word ‘happy’
Choose the Review tab
Click the Thesaurus button. 
The thesaurus dialog box appears.

1
2
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3.8 Find and Replace 

Your word processor can help you search for particular words in your document. This is 
very helpful especially when you need to search through a long document.

After you find the word or phrase you are searching for, you can replace it with new 
text by executing the Replace command. 

Use Find option

Type the following: I love cats. Cats are gentle and cuddly.
Select the sentence
Choose the Home tab
Click Find in the Editing group. A menu appears.

Click the Find option on the menu. The Find and Replace dialog box appears.

1
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Type cats in the Find What field
Click Find Next
 Note that the ‘cats’ (first one) is highlighted
Click Find Next again
 Note that ‘Cats’ (second one) is highlighted
Click Find Next. The following message should appear: ‘Word has finished searching 
 the selection. Do you want to search the remainder of the document?’
Click No 
Click Cancel

Use Replace option

Select the sentence ‘I love cats. Cats are gentle and cuddly.’
Choose the Home tab
Click Replace in the Editing group. The Find and Replace dialog box appears.
Type cats in the Find What box
Type tigers in the Replace With box
Click Find Next. The first occurrence of the word ‘cats’ is highlighted

1
2
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Click Replace. Word replaces the ‘cats’ with ‘tigers’ and then highlights the second 
 occurrence of the word ‘cats.’ 
Click Replace. Word replaces the word ‘cats’ with ‘tigers’
Click Close

Your text should now read, ‘I love tigers. Tigers are gentle and cuddly.’

7

8
9
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3.9 Using drawing Toolbar 

Click on insert tab, next click on Shapes. Now click on New Drawing canvas.

 The format tab will appear as follows:

You will notice that the options on the Ribbon have changed. It is categorized into five 
sections labeled: Insert Shapes, Shape Styles, Shadow Effects, 3-D Effects, Arrange, and 
Size. Each capabilities are described as follows:
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Insert Shapes

Here you can add lines, basic shapes, or flowchart symbols to your canvas with just one 
click.

Practical Lab Activity

Insert Shapes

1. Click on insert tab
2. Click on shapes
3. Click on new drawing canvas
4. Click here to see all the shapes available
5. Insert the following shapes in your canvas:
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Shape Styles allows users to choose how they would like to fill the shape.
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Practical Lab Activity 

Shape Styles

1. Draw four circles and click here to see all the shape styles.
2. Change the style of the circles as follows:

Shadow Effects

If you would like to add shadow effects to your canvas, this option 
gives a variety of choices.

Unit 3: Word Processing

Information & Communication Technology96



Practical Lab Activity

Shadow Effects

1. Insert a triangle, circle and rectangle as shown below.
2. Click on shadow effects to add shadow to these three shapes as follows:

3-D Effects

This option allows you to experiment with different 3-D effects that allow 
you to make changes to your canvas color, lighting, surface, direction 
and depth.
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Practical Lab Activity

3-D Effects

1. Again, insert a triangle, circle and rectangle
2. Click on each shape and click on 3-D effects. The appearance of 
    the shapes will change as follows:

Arrange

This option helps to position the canvas. Methods of positioning can 
range from text wrapping, alignment, and rotation.

Positioning of canvas
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Practical Lab Activity 

Arrange

Change different positions of your canvas (created in class activity 3-D 
effects) by clicking on position.

Figure below shows middle center position.

Size

This feature allows users to adjust the width and height of the canvas. 
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Practical Lab Activity

Size

1. Click on size.
2. Change the height to 15
    and size to 25 as shown 
    below:

3.10 Insert picture

To insert a picture, follow these steps:
Click on Insert tab
Click on Picture

Select the picture you wish to insert

1
2
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Choose a picture
Click on Insert

The picture will be inserted in your document

4
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3.11 Use clip art to insert picture
Clip art is a collection of simple pictures or drawings found in MS Word.

Click on the Insert tab, in the Illustrations group, click Clip Art.

The Clip Art task panel appears as follows:

1

1
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In the Clip Art task pane, in the Search for text box, type animals
Click Go.
In the list of results, click the picture of any animal to insert it.4

2
3

3.12 Format pictures 

There are two ways of resizing pictures:
With the mouse
With the picture command

Resizing picture with the mouse

To format your picture, follow these steps:
Click on the picture. What happens?  
 ..................................................................................

1

1

2



To increase or decrease the size of the picture drag the corner handle. When you 
are satisfied with the size, release the mouse button.

Resizing picture with the picture command

Click on the picture
Click on Format 

       Click on Size
You will be provided with the height and width. Increase the height and decrease 
the height and observe what happens.

Size

1

2

2

Unit 3: Word Processing

Information & Communication Technology104

3.13 Insert and format tables 

A table is made up of rows and columns of cells that you can fill with text and graphics. 
Tables are often used to organize and present information.

Creating a table

To create a table, follow these steps:
Place the cursor where you want the table to be created.
Click on insert tab, click on Table.		  
The following window will appear, click on Insert Table.

1
2
3
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2

Under table size, enter the Number of columns and rows.4

4

Format tables

Selecting table styles

You can format the table by clicking here.1



A set of table styles will appear as follows: 

Choose any one.

1

2
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Changing alignment of text in tables

Create the following table and insert the text as shown below:

To change the alignment of text, follow these steps:
Highlight the table
Right click on the table
Click on Cell alignment

Choose Align center

The table will appear as follows:

1

1

4
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Changing borders in tables

To change the borders, follow these steps:
Highlight the table
Right click on the table
Click on Borders and Shading

The following window will appear:
Select a border

1
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Your table will appear as follows:

To add a row below:

Create a table with 4 rows and 5 columns.
Add the following text to your table:

Right-click in  cell A, to add a row below.
Click on Insert
Click on Insert Rows Below

1
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A new row will be added below the cell as follows:

NOTE: to add rows above, follow same steps as above, but at step 3, click on insert rows 
above.

To add a column to the right 
Create a table with 2 rows and 5 columns
Right-click in first cell in column 5, to add a column to the right.
Click on Insert
Click on Insert columns to the right

1
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A new column will be added to the right as follows:

NOTE: to add columns to the left, follow same steps as above, but at step 3, click on 
insert columns to the right.

Class Activity 

A. Circle the letter which shows the correct 
answer

1. In MS Word we can use the .............................   
    feature to look up synonyms of words in our document.
A Spelling and grammar	    B bulleted list	    C Clip Art	     D Thesaurus

2. ........................................... is a collection of pictures and drawings 
    present in MS Word
A   Programs	 B    WordArt		 C  Text	 D  Clip Art

3. MS Word underlines words which are not correctly spelt with 
    ......................................
A  a straight line	 B  a green line	 C  a red line		 D  a black line

Instructions to teachers:
Do the activity orally 
first, followed by written 
tasks.



Class Activity 

B. Write true or false in the box at the end of 
each sentence.

1. The Find and Replace feature allows you to find   	

    a word or phrase in your text.

2. We cannot add or delete columns and rows in a table.

3. We cannot type text in a table.

C. Match the following buttons to its respective function:

 					     Appears at the top of every page

 					     Numbered list

 					     Used to insert a picture

 					     Is used to search for a word in your 		

					     document

 					     Inserts a table

 					     Bulleted list

 					     Appears at the bottom of every 		

					     page

Instructions to teachers:
Do the activity orally 
first, followed by written 
tasks.
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Instructions:

• Before starting the following activity, type your name and class.
• After completing this activity, print a copy to be kept in your folder.

Type the following text according to the format given:

UNIT 3: ACTIVITY SHEET 1

Font style: Arial black
Font size: 36
Font color: Blue
Put text to italic and underline

Font style: Bradley Hand ITC
Font size: 14
Font color: Black
Put text to bold





Instructions:

• Before starting the following activity, type your name and class.
• After completing this activity, print a copy to be kept in your folder.

Type the following text

What is a virus?

A computer virus is a small computer program that spreads from one 
computer to another computer. They can also try to damage your 
software, your hardware, and your files. A computer virus may corrupt 
or delete data on a computer, use an e-mail program to spread the 
virus to other computers, or even delete everything on the hard disk.

What is a worm?

A worm, like a virus, is designed to copy itself from one computer 
to another, but it does so automatically. Once a worm is in your 
system, it can travel alone. A great danger of worms is their ability 
to reproduce in great volume. For example, a worm could send out 
copies of itself to everyone listed in your e-mail address book.

Instructions:

1. Right align first paragraph and insert 1.5 line spacing.
2. Justify second paragraph and insert double spacing.

NOTE: your document should be as follows:

What is a virus?

A computer virus is a small computer program that spreads from 
one computer to another computer.They can also try to damage 

your software, your hardware, and your files. A computer virus may 
corrupt or delete data on a computer, use an e-mail program to 

spread the virus to other computers, or even delete everything on 
the hard disk.

What is a worm?

A worm, like a virus, is designed to copy itself from one computer to 
another, but it does so automatically. Once a worm is in your system, it 
can travel alone. A great danger of worms is their ability to reproduce 
in great volume. For example, a worm could send out copies of itself 
to everyone listed in your e-mail address book.
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Instructions:

• Before starting the following activity, type your name and class.
• After completing this activity, print a copy to be kept in your folder.

Type the following text:

Computer laboratory guidelines

> Ask your teacher permission before performing any activity in 
   the laboratory.
> Do not step on computer cables.
> Do not run or play n the laboratory.
> Do not eat or drink in the laboratory.

PC care guidelines

1.	 Do not operate your PC during heavy rain or lightning.
2.	 Do not touch any internal part of the computer.
3.	 Avoid exchanging pen drives with your friends.
4.	 Scan your pen drive for any virus before using it. 

Instructions:

1. Use bullets for first paragraph.
2. Use numbering for second paragraph.
3. Insert the header: guidelines.
4. Insert page number.
5. Insert a page border.
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Instructions:

• Before starting the following activity, type your name and class.
• After completing this activity, print a copy to be kept in your folder.

Type the following text:

The sun shins on the magic forest. It also shines on a giante oak tree, 
many centuries old. It’s in this tree that Mary’s family lives. Mary is 
a young Fairy; she’s very small, barely a few centimeters like all the 
fairies of her race. 

The problem is that poore Mary is suffering from a myssterious illness. 
The magician was very upsett. He had never encountered any such 
sicknesse before. He searched the memorie books left by previous 
magician but to no avail.

1. Run spelling and grammar check
2. Change the following words:
    Shins to shines
    Giante to giant
    Poore to poor
    Myssterious to mysterious
    Upsett to upset
    Sicknesse to sickness
    Memorie to memory

3. Use thesaurus to change 
    small to little
    illness to disease
    problem to trouble
    previous to preceding

4. Use find and replace to  
    replace the word Mary 
    with Sarah.
5. Add paragraph border and 
    shading (any colour).
6. Your document will be as 
    follows:
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Instructions:

• Before starting the following activity, type your name and class.
• After completing this activity, print a copy to be kept in your folder.

Reproduce the following, by using the different shapes.  
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Instructions:

• Before starting the following activity, type your name and class.
• After completing this activity, print a copy to be kept in your folder.

 Using shapes, draw the following:
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Instructions:

• Before starting the following activity, type your name and class.
• After completing this activity, print a copy to be kept in your folder.

1. Create a table with 6 rows and 4 columns and insert the data as follows:

2. Change text alignment to align center
3. Change table style
4. Change border and click on preview to apply border to four sides of table.
5. Add a row below Anna to insert the name: Jane and add the marks as    
    follows:  Maths: 50, English: 70, French: 80.
6. Add a column to the right of English and insert the heading Science.
7. Your table should be as follows:
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